Preface

Getting Started

Open the Part to Machine
Create a Lathe Roughing Operation
Replay the Toolpath
Create a Lathe Grooving Operation
Create Lathe Profile Finishing Operation
Generate NC Code

Basic Tasks

Lathe Machining Operations

Longitudinal Roughing
Face Roughing
Parallel Contour Roughing
Recessing
Grooving
Profile Finishing
Groove Finishing
Threading

Axial Machining Operations
Manufacturing Entities
Auxiliary Operations
Verification, Simulation and Program Output
Part Operations, Programs and Processes

Advanced Tasks

Workbench Description

Menu Bar
Toolbars
Specification Tree

Customizing

Reference Information

Lathe Operations
Cutter Compensation and Finish Operations
Changing the Output Point
Preface

Lathe Machining easily defines NC programs dedicated to machining 3D cylindrical parts using 2-axis turning and drilling operations, for both horizontal and vertical spindle lathe machines.

Quick tool path definition is ensured thanks to an intuitive user interface based on graphic dialog boxes. Tools can be easily created and integrated to tool catalogs. Tool path can be generated, simulated and analyzed. Whole manufacturing process is covered from tool path definition to NC data generation thanks to an integrated postprocessor execution engine. Shop floor documentation is automatically created in HTML format. Finally, associativity with Version 5 design products allows productive design change management.

Suitable for all kinds of cylindrical machined parts, Lathe Machining fits the needs of Fabrication & Assembly industry, as well as all industries where lathe machining techniques are involved. It can be used in shop-floors as a stand-alone product for CAM-centric customers, who will particularly appreciate the product’s ease-of-use and high level of manufacturing capabilities. Lathe Machining can be combined with DELMIA products for overall manufacturing process integration, simulation and optimization, particularly for bigger customers concerned by high quality and quick time-to-market.

Certain portions of this product contain elements subject to copyright owned by the following entities:

© Copyright LightWork Design Ltd., all rights reserved.
© Copyright Deneb Robotics Inc., all rights reserved.
© Copyright Cenit, all rights reserved.
© Copyright Intelligent Manufacturing Software, all rights reserved.
© Copyright Walter Tool Data Management, all rights reserved.
Before getting into the detailed instructions for using Lathe Machining, this tutorial is intended to give you a feel of what you can accomplish with the product.

It provides the following step-by-step scenario that shows you how to use some of the key functionalities.

- Open the Part to Machine
- Create a Lathe Roughing Operation
- Replay the Toolpath
- Create a Lathe Grooving Operation
- Create Lathe Profile Finishing Operation
- Generate NC Code
Open the Part to Machine

This first task shows you how to open a part, enter the Lathe Machining workbench and make basic modifications to the Part Operation.

1. Select File > Open then select the `Lathe01.CATPart` document.

2. Select NC Manufacturing > Lathe Machining from the Start menu.

   The Lathe Machining workbench appears.

3. Double click Part Operation.1 in the tree to display the Part Operation dialog box.

4. Click the Machine icon, then in the Machine Editor dialog box:
   - select the Horizontal Lathe Machine icon
   - make sure that the radial axis is set to X and the spindle axis is set to Z
   - click OK.

5. Set the tool change point in the Position tab page as shown below.

6. Click OK to confirm your modifications to the Part Operation.

7. Select Manufacturing Program.1 in the tree to make it the current entity.

To insert program entities such as machining operations, tools and auxiliary commands you can either:
- make the program current before clicking the `insert program entity` command
- click the `insert program entity` command then make the program current.
Create a Lathe Roughing Operation

This task shows you how to create a Longitudinal Roughing operation for machining part of the workpiece.

This operation will use the tool proposed by the program, so you just need to specify the geometry to be machined and set some of the machining parameters.

1. Select the Roughing icon.

A Roughing.1 entity along with a default tool is added to the program. The Roughing dialog box appears directly at the Geometry tab page.

2. Click the red Stock area in the icon, then select the stock profile as shown.

Click OK in the Edge Selection toolbar to end your selection.

3. Click the red Part area in the icon, then select the part profile as shown.

Click OK in the Edge Selection toolbar to end your selection.

4. Select the Strategy tab page and set the parameters as shown.

5. Click OK to create the operation.
Replay the Tool Path

This task shows you how to replay the tool path of the Roughing operation.

1. Select the Roughing operation in the tree then select the Replay Tool Path icon. The Replay dialog box appears.

2. Choose the Continuous replay mode by means of the drop down icon.

3. Click the button to position the tool at the start point of the operation.

4. Click the button to start the replay. The tool moves along the computed trajectory.

5. Click OK to quit the replay mode.
Create a Lathe Grooving Operation

This task shows you how to create a Grooving operation to machine part of the workpiece.

You will specify the geometry to be machined, set some of the machining parameters and select a new tool.

Make sure that the Roughing operation is the current entity in the program.

1. Select the Grooving icon.
   
   The Grooving dialog box appears directly at the Geometry page.

2. Click the red Stock area in the icon, then select the stock profile as shown.

3. Click the red Part area in the icon, then select the groove profile as shown.

4. Select the Strategy tab page and check machining parameters. Set the Gouging Safety Angle to 10 degrees.

5. Select the Tool tab in the Tool Assembly tab page.
   
   - Enter a name of the new tool (for example, Grooving Tool).
   - Double click the l2 (shank length 2) parameter in the icon, then enter 60mm in the Edit Parameter dialog box.
   - Set the Max cutting depth Technology parameter to 80mm.

6. Click Replay in the dialog box to visually check the operation's tool path.
Click OK to exit the replay mode and return to the Grooving dialog box.

7. Click OK to create the operation.
Create a Lathe Profile Finishing Operation

This task shows you how to insert a Profile Finishing operation in the program.

1. Select the Profile Finishing icon.
   The Profile Finishing dialog box appears directly at the Geometry page.

2. Select the red part in the sensitive icon then select the part profile.

3. Select the Strategy tab page and set the Leading Safety Angle to 0 degrees.

4. Click Replay to replay the operation as described previously.

Click OK to exit the replay mode and return to the Profile Finishing dialog box.

10. Click OK to create the operation in the program.
Generate NC Code

This task shows you how to generate the APT format NC code from the program.

Before doing this task, double click the Part Operation entity in the tree and, in the dialog box that appears, click the Machine icon to access the Machine Editor dialog box. Make sure that you have selected a Horizontal lathe machine and that the desired NC data format is set to Axis (X, Y, Z).

1. Use the right mouse key on the Manufacturing Program.1 entity in the tree to select Generate NC Code Interactively. The Save NC File dialog box appears.

2. Select the folder where you want the file to be saved and specify the name of the file.

3. Click Save to create the APT file.

Here is an extract from the Apt source file that could be generated:

```plaintext
$$ -------------------------------
$$ Generated on Tuesday, May 15, 2001 05:14:58 PM
$$ -------------------------------
$$ Manufacturing Program.1
$$ Part Operation.1
$$*CATIA0
$$ Manufacturing Program.1
$$ 1.00000 0.00000 0.00000 0.00000
$$ 0.00000 1.00000 0.00000 0.00000
$$ 0.00000 0.00000 1.00000 0.00000
PARTNO PART TO BE MACHINED
COOLNT/ON
CUTCOM/OFF
PPRINT OPERATION NAME : Lathe Tool Change.1
$$ Start generation of : Lathe Tool Change.1
TLAXIS/ 0.000000, 0.000000, 1.000000
$$ TOOLCHANGEBEGINNING
RAPID
GOTO/ 125.00000, 0.00000, 275.00000
CUTTER/ 5.000000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.1
PPRINT OPERATION NAME : Roughing.1
$$ Start generation of : Roughing.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO/ 107.02703, 0.00000, 257.00000
GOTO/ 107.02703, 0.00000, 255.00000
...
FEDRAT/ 0.8000,MMPR
GOTO/ 0.21213, 0.00000, 225.21213
$$ End of generation of : Roughing.1
CUTCOM/OFF
$$ ------- CUTCOM OFF END OF LATHE ------
PPRINT OPERATION NAME : Lathe Tool Change.2
$$ Start generation of : Lathe Tool Change.2
$$ TOOLCHANGEBEGINNING
RAPID
```
GOTO/ 125.00000, 0.00000, 275.00000
CUTTER/ 1.200000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.2
PPRINT OPERATION NAME : Grooving.1
$$ Start generation of : Grooving.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO/ 108.20000, 0.00000, 111.70000
GOTO/ 106.20000, 0.00000, 111.70000
...
RAPID
GOTO/ 108.20000, 0.00000, 57.91213
$$ End of generation of : Grooving.1
CUTCOM/OFF
$$ ------ CUTCOM OFF END OF LATHE ------
PPRINT OPERATION NAME : Lathe Tool Change.3
$$ Start generation of : Lathe Tool Change.3
$$ TOOLCHANGEBEGINNING
RAPID
GOTO/ 125.00000, 0.00000, 275.00000
CUTTER/ 5.000000
TOOLNO/0,TURN
$$ End of generation of : Lathe Tool Change.3
PPRINT OPERATION NAME : Profile Finishing.1
$$ Start generation of : Profile Finishing.1
FEDRAT/ 0.3000,MMPR
SPINDL/ 70.0000,RPM
GOTO/ 27.12132, 0.00000, 224.94975
GOTO/ 28.53553, 0.00000, 223.53553
...
FEDRAT/ 0.8000,MMPR
GOTO/ 100.21213, 0.00000, 4.78787
$$ End of generation of : Profile Finishing.1
SPINDL/OFF
REWIND/0
END
Basic Tasks

The basic tasks you will perform with Lathe Machining involve creating, editing and managing machining operations and other entities of the NC manufacturing process.

- Lathe Machining Operations
- Axial Machining Operations
- Manufacturing Entities
- Auxiliary Operations
- Verification, Simulation and Program Output
- Part Operations, Programs and Processes
Lathe Machining Operations

The tasks in this section show you how to create lathe machining operations in your manufacturing program.

Create a Roughing operation:
Select the Roughing icon and choose the desired roughing mode. You can then select the part and stock geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.

Basic tasks illustrate the following roughing modes:
- **Longitudinal**
- **Face**
- **Parallel Contours**

Create a Recessing operation:
Select the Recessing icon and choose the desired recessing mode. You can then select the part and stock geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.

Create a Grooving operation:
Select the Grooving icon then select the part and stock geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.

Create a Profile Finishing operation:
Select the Profile Finishing icon then select the part profile and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.

Create a Groove Finishing operation:
Select the Groove Finishing icon then select the part geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.

Create a Threading operation:
Select the Threading icon and choose the desired thread type. You can then select the part geometry and specify the tool to be used. Specify machining parameters, feeds and speeds, and NC macros as needed.
Create a Longitudinal Roughing Operation

This task illustrates how to create a **Longitudinal Roughing operation** in the program.

To create the operation you must define:
- the **geometry** to be machined
- the **tool** that will be used
- the parameters of the **machining strategy**
- the **feedrates and spindle speeds**
- the **macros (transition paths)**

Open the **Lathe01.CATPart** document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Roughing icon

   A Roughing entity along with a default tool is added to the program.
   The Roughing dialog box appears directly at the Geometry tab page.
   This tab page includes a sensitive icon to help you specify the geometry to be machined.

   The part and stock of the icon are colored red indicating that this geometry is required. All other geometry is optional.

2. Click the red part in the icon then select the desired part profile in the 3D window.
   The part of the icon is now colored green indicating that this geometry is now defined.

3. Click the red stock in the icon then select the desired stock profile in the 3D window.
4. Double click **Thickness on Part** in the icon.
   Set this value to 5mm in the Edit Parameter dialog box and click OK.
5. Select the Strategy tab page to specify the main machining strategy parameters:
   - Roughing mode: **Longitudinal**
   - Orientation: **External**
   - Location: **Front**.
6. Double click Max depth of cut in the icon. Set this value to 15mm in the Edit Parameter dialog box and click OK.

Other optional parameters can be set in the Options tab page (lead-in and so on).

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

Please refer to Edit the Tool of an Operation.

7. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See Feeds and Speeds for Roughing for more information.

8. Select the Macros tab page to specify the operation's transition paths (approach and retract motion, for example). See Define Macros of an Operation for an example of specifying transition paths on a machining operation.

Before accepting the operation, you should check its validity by replaying the tool path.

9. Click OK to create the operation.
Create a Face Roughing Operation

This task shows how to insert a Face Roughing operation in the program.

To create the operation you must define:

- the **geometry** to be machined
- the **tool** that will be used
- the parameters of the **machining strategy**
- the **feedrates and spindle speeds**
- the **macros (transition paths)**

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Roughing icon

   The Roughing dialog box appears directly at the Geometry tab page

   This page includes a sensitive icon to help you specify the geometry to be machined.

   The part and stock in the icon are colored red indicating that this geometry is required for defining the operation.

2. Click the red part in the icon then select the desired part profile in the 3D window.

   The part of the icon is now colored green indicating that this geometry is now defined.

3. Click the red stock in the icon then select the desired stock profile in the 3D window.

4. Double click **Thickness on Part** in the icon.

   Set this value to 5mm in the Edit Parameter dialog box and click OK.

5. Select the Strategy tab page to specify the main machining strategy parameters:

   - Roughing mode: **Face**
   - Orientation: **External**
   - Location: **Front**
6. Double click **Max depth of cut** in the icon.
   Set this value to 10mm in the Edit Parameter dialog box and click OK.

7. In the Options tab page, set the lift-off distance to 1.5mm.

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in [Edit the Tool of an Operation](#).

8. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See [Feeds and Speeds for Roughing](#) for more information.

   If you want to specify approach and retract motion for the operation, select the Macros tab page to specify the desired transition paths.

   The general procedure for this is described in [Define Macros of an Operation](#).

9. Check the validity of the operation by [replaying the tool path](#).
10. Click OK to create the operation.
Create a Parallel Contour Roughing Operation

This task shows how to insert a Parallel Contour Roughing operation in the program.

To create the operation you must define:

- the geometry to be machined
- the tool that will be used
- the parameters of the machining strategy
- the feedrates and spindle speeds
- the macros (transition paths)

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Roughing icon.

A Roughing entity along with a default tool is added to the program.

The Roughing dialog box appears directly at the Geometry tab page.

This tab page includes a sensitive icon to help you specify the geometry to be machined.

The part and stock of the icon are colored red indicating that this geometry is required.

2. Click the red part in the icon, then select the desired part profile in the 3D window.

Select the stock in the same way.

3. Select the Strategy tab page to specify the main machining strategy parameters:

- Roughing mode: **Parallel Contour**
- Orientation: **External**
- Location: **Front**
- Machining direction: **To head stock**
4. Double click **Axial depth of cut** in the icon.
Set this value to 3mm in the Edit Parameter dialog box and click OK.
Set **Radial depth of cut** to 3mm in the same way.

Other optional parameters can be set in the Options tab page (lead-in and so on).

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in [Edit the Tool of an Operation](#).

5. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See [Feeds and Speeds for Roughing](#) for more information.

6. If you want to specify approach and retract motion for the operation, select the Macros tab page to specify the desired transition paths.

The general procedure for this is described in [Define Macros of an Operation](#).

Before accepting the operation, you should check its validity by replaying the tool path.
7. Click OK to create the operation.
Create a Recessing Operation

This task shows how to insert a Recessing operation in the program.

To create the operation you must define:

- the **geometry** to be machined
- the **tool** that will be used
- the parameters of the **machining strategy**
- the **feedrates and spindle speeds**
- the **macros (transition paths)**

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Recessing icon

   A Recessing entity along with a default tool is added to the program.
   The Recessing dialog box appears directly at the **Geometry tab page**.
   This tab page includes a sensitive icon to help you specify the geometry to be machined.

   The part and stock in the icon are colored red indicating that this geometry is required.

2. Click the red part in the icon then select the desired part profile in the 3D window.

   Select the stock in the same way.

3. Select the **Strategy tab page** to specify the main machining strategy parameters:
   - **Recessing mode**: Zig zag
   - **Orientation**: External
   - **Machining direction**: To head stock

4. Double click **Max depth of cut** in the icon.

   Set this value to 10mm in the Edit Parameter dialog box and click OK.

   Other optional parameters can be set in the Options tab page (lead-in and so on).
A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in Edit the Tool of an Operation.

5. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See Feeds and Speeds for Recessing for more information.

6. If you want to specify approach and retract motion for the operation, select the Macros tab page to specify the desired transition paths.

   The general procedure for this is described in Define Macros of an Operation.

   Before accepting the operation, you should check its validity by replaying the tool path.

7. Click OK to create the operation.
Create a Grooving Operation

This task shows how to insert a Grooving operation in the program.

To create the operation you must define:

- the geometry to be machined
- the tool that will be used
- the parameters of the machining strategy
- the feedrates and spindle speeds
- the macros (transition paths)

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Grooving icon

   The Grooving dialog box appears directly at the Geometry tab page.

   This page includes a sensitive icon to help you specify the geometry to be machined.

   The part and stock in the icon are colored red indicating that this geometry is required for defining the operation.

2. Click the red part in the icon, then select the desired part profile in the 3D window.

   Select the stock in the same way.

   The part and stock of the icon are now colored green indicating that this geometry is now defined.

3. Select the Strategy tab page to specify the main machining strategy parameters:
   - Orientation: External
   - First plunge position: Center
   - Next plunges position: To head stock

4. Double click Max depth of cut in the icon.

   Set this value to 10mm in the Edit Parameter dialog box and click OK.
Other optional parameters can be set in the Options tab page (lead-in and so on).

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in Edit the Tool of an Operation.

5. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See Feeds and Speeds for Grooving for more information.

You can add approach and retract motions to the operation in the Macros tab page. This is described in Define Macros of an Operation.

6. Check the validity of the operation by replaying the tool path.

7. Click OK to create the operation.
Create a Profile Finishing Operation

This task shows how to insert a Profile Finishing operation in the program.

To create the operation you must define:
- the geometry to be machined
- the tool that will be used
- the parameters of the machining strategy
- the feedrates and spindle speeds
- the macros (transition paths)

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Profile Finishing icon.

The Profile Finishing dialog box appears directly at the Geometry tab page.

This page includes a sensitive icon to help you specify the geometry to be machined.

The part in the icon is colored red indicating that this geometry is required for defining the operation.

2. Click the red part in the icon, then select the desired part profile in the 3D window.

The part of the icon is now colored green indicating that this geometry is now defined.

4. Select the Strategy tab page to specify the main machining strategy parameters:
   - Orientation: External
   - Location: Center
   - Machining direction: To spindle
   - Select Recess machining checkbox.

Other optional parameters can be set in the Machining and Corner processing tab pages.
A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in Edit the Tool of an Operation.

5. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See Feeds and Speeds for Profile Finishing for more information.

You can add approach and retract motions to the operation in the Macros tab page. This is described in Define Macros of an Operation.

6. Check the validity of the operation by replaying the tool path.

7. Click OK to create the operation.
Create a Groove Finishing Operation

This task shows how to insert a Groove Finishing operation in the program.

To create the operation you must define:
- the **geometry** to be machined
- the **tool** that will be used
- the parameters of the **machining strategy**
- the **feedrates and spindle speeds**
- the **macros (transition paths)**

Open the Lathe01.CATPart document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Groove Finishing icon.

A Groove Finishing entity along with a default tool is added to the program.

The Groove Finishing dialog box appears directly at the Geometry tab page.

This tab page includes a sensitive icon to help you specify the geometry to be machined.

The part in the icon is colored red indicating that this geometry is required.

2. Click the red part in the icon then select the desired part profile in the 3D window.

3. Select the Strategy tab page to specify the main machining strategy parameters:
   - Orientation: **External**
   - Machining direction: **To head stock**
   - Contouring for outside corners: **Circular**.

Other optional parameters can be set in the Machining and Corner processing tab pages.

A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in **Edit the Tool of an Operation**.
4. Select the Feeds and Speeds tab page to specify the feedrates and spindle speeds for the operation. See Feeds and Speeds for Finish Grooving for more information.

5. Select the Macros tab page to specify the operation's transition paths (approach and retract motion, for example). See Define Macros of an Operation for an example.

Before accepting the operation, you should check its validity by replaying the tool path.

6. Click OK to create the operation.
Create a Threading Operation

This task shows how to insert a **Threading operation** in the program.

To create the operation you must define:
- the **geometry** to be machined
- the **tool** that will be used
- the parameters of the **machining strategy**
- the **feedrates and spindle speeds**
- the **macros (transition paths)**

Open the **Lathe01.CATPart** document, then select NC Manufacturing > Lathe Machining from the Start menu. Make the Manufacturing Program current in the specification tree.

1. Select the Threading icon.

   A Threading entity along with a default tool is added to the program.
   The Threading dialog box appears directly at the **Geometry tab page**.
   This tab page includes a sensitive icon to help you specify the geometry to be machined.

   The part in the icon is colored red indicating that this geometry is required.

2. Click the red part in the icon then select the desired part profile in the 3D window.

3. Double click Length in the icon then specify the desired length of threading in the Edit Parameters dialog box that appears.

4. Select the **Strategy tab page**
   to specify the main machining strategy parameters:
   - Profile: **Other**
   - Orientation: **External**
   - Location: **Front**
   - Thread unit: **Pitch**
   - Number of threads: **2**.

5. Other optional parameters can be set in the Strategy and Options tab pages.
A tool is proposed by default when you want to create a machining operation. If the proposed tool is not suitable, just select the Tool tab page to specify the tool you want to use.

This is described in Edit the Tool of an Operation.

6. Select the Feeds and Speeds tab page to specify the machining spindle speed for threading.

7. Select the Macros tab page to specify the operation's transition paths (approach and retract motion, for example). See Define Macros of an Operation for an example of specifying transition paths. Before accepting the operation, you should check its validity by replaying the tool path.

8. Click OK to create the operation.
Axial Machining Operations

The tasks for creating axial machining operations are documented in the *Prismatic Machining User's Guide*.

**Spot Drilling Operation**

Create a Spot Drilling Operation: Select the Spot Drilling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

**Drilling Operations**

Create a Drilling Operation: Select the Drilling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Drilling Dwell Delay Operation: Select the Drilling Dwell Delay icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Drilling Deep Hole Operation: Select the Drilling Deep Hole icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Drilling Break Chips Operation: Select the Drilling Break Chips icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

**Hole Finishing Operations**

Create a Reaming Operation: Select the Reaming icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Counterboring Operation: Select the Counterboring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

**Boring Operations**

Create a Boring Operation: Select the Boring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Boring Spindle Stop Operation: Select the Boring Spindle Stop icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Boring and Chamfering Operation: Select the Boring and Chamfering icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Back Boring Operation: Select the Back Boring icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters,macros and feeds and speeds as needed.

**Threading Operations**

Create a Tapping Operation: Select the Tapping icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Reverse Threading Operation: Select the Reverse Threading icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Thread without Tap Head Operation: Select the Thread without Tap Head icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Thread Milling Operation: Select the Thread Milling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.
Countersinking and Chamfering Operations

Create a Countersinking Operation: Select the Countersinking icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Chamfering Two Sides Operation: Select the Chamfering Two Sides icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

T-Slotting and Circular Milling

Create a T-Slotting Operation: Select the T-Slotting icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros and feeds and speeds as needed.

Create a Circular Milling Operation: Select the Circular Milling icon then select the hole or hole pattern to be machined and specify the tool to be used. Specify machining strategy parameters, macros, and feeds and speeds as needed.
Manufacturing Entities

The tasks for creating and managing specific entities of the NC manufacturing environment are documented in the *NC Manufacturing Infrastructure User’s Guide*.

- **Select or Create a Tool**: Double click the machining operation in the program and select the Tool tab page to edit the tool characteristics or search for a new tool.
- **Edit a Tool Referenced in the Program**: Double click a tool referenced in the program or resource list and edit the tool characteristics in the Tool Definition dialog box.
- **Specify Tool Compensation Information**: Double click a tool referenced in the program or resource list and specify the tool compensation information in the Compensation tab page of the Tool Definition dialog box.
- **Create and Use Machining Patterns**: Select Insert > Machining Feature > Machining Pattern then select a pattern of holes to be machined.
- **Feature Based Programming**: Select a feature using the Manufacturing view and create operations based on this feature.
- **Define Macros on a Milling Operation**: Select the Macros tab page when creating or editing a milling operation, then specify the transition paths of the macros to be used in the operation.
- **Define Macros on an Axial Machining Operation**: Select the Macros tab page when creating or editing an axial machining operation, then specify the transition paths of the macros to be used in the operation.
- **Manage the Status of Manufacturing Entities**: Use the status lights to know whether or not your operation is correctly defined.
Auxiliary Operations

The tasks for inserting auxiliary operations in the program are documented in the *NC Manufacturing Infrastructure User's Guide*.

- **Insert Tool Change**: Select the Tool Change icon then select the tool type to be referenced in the tool change.
- **Insert Machine Rotation**: Select the Machine Rotation icon then specify the tool rotation characteristics.
- **Insert Machining Axis System or Origin**: Select the Machining Axis or Origin icon then specify the characteristics of the machining axis system or origin.
- **Insert PP Instruction**: Select the PP Instruction icon then enter the syntax of the PP instruction.
Verification, Simulation and Program Output

The tasks for using capabilities such as tool path verification, material removal simulation, and production of NC output data are documented in the *NC Manufacturing Infrastructure User's Guide*.

- **Replay Tool Path**: Select the Tool Path Replay icon then specify the display options for an animated tool path display of the manufacturing program of machining operation.
- **Simulate Material Removal** *(P2 Functionality)*: Select the desired icon in the Tool Path Replay dialog box to run a material removal simulation either in Photo or Video mode.
- **Generate APT Source Code in Batch Mode**: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the APT source processing options.
- **Generate NC Code in Batch Mode**: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the NC code processing options.
- **Generate Clfile Code in Batch Mode**: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the Clfile code processing options.
- **Generate a CGR File in Batch Mode** *(P2 Functionality)*: Select the Generate NC Code in Batch Mode icon then select the manufacturing program to be processed and define the CGR processing options.
- **Generate APT Source Code in Interactive Mode**: Select the Generate NC Code Interactively icon to generate APT source code for the current manufacturing program.
- **Generate NC Documentation**: Select the Generate Documentation icon to produce shop floor documentation in HTML format.
- **Import an APT Source into the Program**: Select the APT Import contextual command to insert an existing APT source into the current manufacturing program.
The tasks for creating and managing Part Operations, Manufacturing Programs and Machining Processes are documented in the NC Manufacturing Infrastructure User's Guide.

**Create and Edit a Part Operation:** Select the Part Operation icon then specify the entities to be referenced by the part operation: machine tool, machining axis system, tool change point, part set up, and so on.

**Create and Edit a Manufacturing Program:** Select the Manufacturing Program icon to add a program to the current part operation then insert all necessary program entities: machining operations, tool changes, PP instructions, and so on.

**Create a Machining Process (P2 Functionality):** Select the Machining Process icon to create a machining process, which will be stored in a CATProcess document and then as a catalog component.

**Apply a Machining Process (P2 Functionality):** Select the Open Catalog icon to access the machining process to be applied to selected geometry.
Advanced Tasks

Tasks dealing with the following NC Manufacturing functionalities are described in the *NC Manufacturing Infrastructure User's Guide*.

- Design Changes
- Set Up and Part Positioning
Workbench Description

This section contains the description of the menu commands and icon toolbars that are specific to the Lathe Machining workbench.

- Menu Bar
- Toolbars
- Specification Tree
Lathe Machining Menu Bar

The menu commands that are specific to Lathe Machining are described below.

Tasks corresponding to general menu commands are described in the *CATIA Version 5 Infrastructure User’s Guide*.

**Insert Menu**

**Insert > Lathe Operations**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Roughing</td>
<td>Create a Longitudinal Roughing Operation</td>
</tr>
<tr>
<td></td>
<td>Create a Parallel Contour Roughing Operation</td>
</tr>
<tr>
<td>Grooving</td>
<td>Create Grooving Operation</td>
</tr>
<tr>
<td>Recessing</td>
<td>Create Recessing Operation</td>
</tr>
<tr>
<td>Profile Finishing</td>
<td>Create a Profile Finishing Operation</td>
</tr>
</tbody>
</table>
Insert > Auxiliary Operations > Lathe Tool Change

**Description...**

Allows inserting lathe tool changes in the program.
The following icon toolbar is available in the Lathe Machining workbench.

It contains commands to create and edit lathe machining operations as follows.

- Create a **Roughing** operation.
  
  Basic tasks illustrate the following roughing modes:
  
  - **Longitudinal**
  - **Face**
  - **Parallel Contours**.

- Create a **Recessing** operation.

- Create a **Grooving** operation.

- Create a **Profile Finishing** operation.

- Create a **Groove Finishing** operation.

- Create a **Threading** operation.

- Create **Axial Machining Operations**.
Specification Tree

Here is an example of a Process Product Resources (PPR) specification tree for NC Manufacturing products.

**ProcessList** is a plan that gives all the activities and machining operations required to transform a part from a rough to a finished state.

**Part Operation** defines the manufacturing resources and the reference data.

**Manufacturing Program** is the list of all of the operations and tool changes performed.

- Roughing.1 operation is complete and has been computed.
- Roughing.3 operation is complete but has not been computed.
- Roughing.2 operation has not been computed and does not have all of the necessary data (indicated by the exclamation mark).

**ProductList** gives all of the parts to machine.

**ResourcesList** gives all of the tools that can be used in the program.
Customizing

Tasks for customizing your NC Manufacturing environment are described in the *NC Manufacturing Infrastructure User's Guide*.

- NC Manufacturing Settings
- Tools Catalog
- PP Word Syntaxes
- NC Documentation
- Material Simulation Settings
Reference information that is specific to the Lathe Machining product can be found in this section.

- Lathe Machining Operations
- Cutter Compensation for Finish Operations
- Changing the Output Point

Essential reference information on the following topics is provided in the *NC Manufacturing Infrastructure User's Guide*.

- Tool Resources
  - NC Macros
  - PP Tables and PP Word Syntaxes
  - APT Formats
  - CLfile Formats
Lathe Machining Operations

The information in this section will help you create and manage the machining operations supported by the Lathe Machining product. These operations are:

- Roughing
- Recessing
- Grooving
- Profile Finishing
- Groove Finishing
- Threading.

### Roughing Operations

The Roughing operation allow you to specify:

- Longitudinal, Face and Parallel Contour roughing modes
- external, internal or frontal machining according to the type of area to machine
- relimitation of the area to machine
- various approach and retract path types
- various lead-in and lift-off options with specific feedrates
- recess machining
- various contouring options with specific feedrates.

External and Internal turning and grooving tools may be used.

### Geometry for Roughing

Part and Stock profiles are required.

The **End Limit** option allows you to specify a point, line or curve to relimit or extrapolate the selected part profile. The position of the end of machining is defined with respect to this element by one of the following settings: Profile end / To / On /Past.

### Orientation for Roughing

The following **Orientations** are proposed: Internal, External and Frontal (for Face and Parallel Contour Roughing only).

The selected Orientation defines the type of geometric relimitation to be done between the stock and part geometry in order to determine the area to machine. Selected part and stock profiles do not need to be joined (see the following figures).

**External Roughing**
Internal Roughing

Frontal Roughing

Frontal machining is proposed for face roughing. In that case, the minimum and maximum diameters of the area to machine are determined by the stock profile dimensions.

For example, in the following figure the area to machine is relimited by the spindle axis because the stock profile is also relimited by the spindle axis.
Location and Limits for Roughing

The following machining Locations are proposed:

- Front, the part is machined toward the head stock
- Back, the part is machined from the head stock.

Orientation and Location settings determine the way the program closes the area to machine using radial, axial, axial-radial or radial-axial relimitation.

The following options allow you to restrict the area to machine that is pre-defined by the stock and part. You may want to restrict this area due to the physical characteristics of the tool and the type of machining to be done.

Minimum Machining Radius
Maximum Machining Radius (for internal machining)

Note that Max Boring Depth is defined on the tool.

Axial Limit for Chuck Jaws (for external or frontal machining): Offset defined from the machining axis system.

Part and Stock Thicknesses for Roughing

- Clearance on stock, which is defined perpendicular to the stock profile.
- Thickness on part, which is defined perpendicular to the part profile.
- Axial offset on part.
- Radial offset on part.
- End limit clearance: distance with respect to the end element (only if end element is a line or a curve, and when TO or PAST mode is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to the part profile is the resulting value of the normal thickness and the two offsets.

Thickness on part
In this example, a "virtual nose radius" is obtained by adding the specified thickness value to the real nose radius.

**Axial offset on part**

A "virtual part profile" is obtained by translating the part profile the specified offset value along the spindle axis direction.

**Radial offset on part**

A "virtual part profile" is obtained by translating the part profile the specified offset value perpendicular to the spindle axis direction.
Machining Strategy Parameters for Roughing

Path Definition for Roughing

- **Machining tolerance**
- **Max Depth of Cut**
  This option is used to specify the maximum distance between passes.
  It is replaced by Radial Depth of Cut and Axial Depth of Cut for Parallel Contour Roughing.
- **Leading and Trailing Safety Angles**
  The insert geometry is taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Leading Safety Angle and Trailing Safety Angle allow you to further reduce this slope.
  Note that Trailing Angle can be used only when Recess Machining is set.
  Leading and trailing angles can also be defined on the tool to define the maximum slope on which the tool can machine. In this case, the angles that reduce the slope the most will be taken into account.
- **Part Contouring**
  You can specify a contouring type for longitudinal and face roughing in order to clear the part profile by means of the following settings:
  - No: no contouring
  - Each path: profile following at each roughing pass
  - Last path only: profile following at last roughing pass only.
- **Under Spindle Axis Machining**
  For Face Roughing and Parallel Contour Roughing with Frontal machining, this option allows you to request machining under the spindle axis.
- **Machining Direction** (only for Parallel Contour and Face Roughing with Frontal machining)
  You can specify the machining direction with respect to the spindle axis by means of the To/From Spindle Axis choice.
- **Recess Machining** (if Contouring Type is Each Pass or Last Path Only)
  If you require recess machining, activate this checkbox.
  When recess machining is active in Parallel Contour Roughing, the toolpath may not be collision free for some combinations of Axial and Radial Cut Depth.

The following options are proposed for recess machining:

- **Plunge Distance** and **Plunge Angle** (for longitudinal and face roughing)
  Define the plunge vector before each new pass with respect to the cutting direction.
Example of recess with longitudinal external roughing. Note that Trailing angle is defined on the tool.

In the figure above the tool motion is as follows:
- approach in RAPID
- lead-in at the first recess pass and plunge approach for other passes
- plunge at plunge feedrate
- machine at machining feedrate
- contouring at contouring feedrate
- lift-off at last recess pass at lift-off feedrate.

**Lead-in, Lift-off and Attack for Roughing**

These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool damage. Once the attack distance has been run through, the tool moves at machining feedrate.

- **Lead-in Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance. The tool is in rapid mode before this distance.

- **Lead-in Angle**.
  If no lead-in angle is requested, lead-in path is parallel to the machining direction. For Longitudinal and Face Roughing the Lead-in Angle can be applied as follows:
  - no angle applied to lead-in path
  - lead-in angle applied to each path
  - lead-in angle applied to last path only.

- **Attack Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance.
Lift-off Distance and Lift-off Angle

Define the lift-off vector at the end of each new pass with respect to the cutting direction.

For Longitudinal or Face roughing, lift-off occurs:
- at the end of each pass when Contouring Type is set to None or Last Path Only.
- at the end of the last pass of the operation when the contouring type is set to Each Path. This prevents the tool from damaging the part when returning to the end point in RAPID mode.
- at the end of each pass that ends on the stock profile.

For Parallel Contour Roughing, lift-off occurs when the end of the pass has already been machined by a previous pass.

Feeds and Speeds for Roughing

- Speed unit can be set to:
  - Angular: spindle speed in revolutions per minute
  - Linear: constant cutting speed in units per minute

  then you can give a Machining Speed value.
- Machining Feedrate in units per revolution
- Lead-in Feedrate which is applied during the lead-in and attack distance.
- Lift-off Feedrate
- Contouring Feedrate (if contouring type is Each Path or Last Path Only).
- Plunge Feedrate (for longitudinal and face roughing)
Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number of spindle revolutions.

**Compensation for Roughing**

You can select a **tool compensation number** corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

**Approach and Retract Macros for Roughing**

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the approach or retract.

![Diagram of tool motion directions](image)

**Recessing Operation**

The Recessing operation allows you to machine a recess by means of a One Way, Zig Zag or Parallel Contour tool motion.

![Diagram of recessing types](image)

You can specify:
- external, internal, frontal or inclined machining according to the type of area to machine
- various approach and retract path types
various lead-in and lift-off options with specific feedrates
- part contouring
- tool output point change.

This operation supports all lathe tool types and inserts except threading tools.

**Geometry for Recessing**

Part and Stock profiles are required.

**Orientation, Location and Limits for Recessing**

The following **orientations** are proposed: internal, external, frontal and inclined.

The selected orientation defines the type of geometric relimitation to be done between the stock and part geometry in order to determine the area to machine. For an inclined orientation you must specify the **Angle of Incline**.

**Part and Stock Thicknesses for Recessing**

- **Clearance on stock**, which is defined perpendicular to the stock profile
- **Thickness on part**, which is defined perpendicular to the part profile.
- **Axial offset on part**
- **Radial offset on part**.

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to the part profile is the resulting value of the normal thickness and the two offsets.

**Machining Strategy Parameters for Recessing**

**Path Definition for Recessing**

- **Recessing Mode**: One Way, Zig Zag or Parallel Contour
- **Max Depth of Cut**
  This option is used to specify the maximum distance between passes.
  - **Axial** and **Radial Depth of Cut**
    These options are used to specify the maximum axial and radial distances between passes for Parallel Contour mode.
- **Machining tolerance**
- **Machining Direction**
  For Zig Zag tool motion, you must specify a first cutting direction as follows:
  - To or From Head Stock for Internal and External machining
  - To or From Spindle for Frontal machining
  - To Right or Left of Recess for Inclined machining

When a part profile has multiple recesses (that is, a non-convex profile along the cutting direction), only the first recess along the specified direction is machined.

- **Leading and Trailing Safety Angles** for One way and Parallel Contour modes
  The insert geometry is taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Leading and Trailing Safety Angles allow you to further reduce this slope. Note that leading and trailing angles can also be defined on the tool to define the maximum slope on which the tool can machine. In this case, the angles that reduce the slope the most will be taken into account.

- **Gouging Safety Angle** (for Zig Zag mode only)
  Angles of the insert are taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Gouging Safety Angle allows you to further reduce this slope. Note that a gouging angle can also be defined on the tool to define the maximum slope on which the tool can machine. In this case, the angle that reduces the slope the most will be taken into account.

- **Under Spindle Axis Machining**
  For Frontal or Inclined machining, this option allows you to request machining under the spindle axis.

- **Part Contouring**
  You can specify if contouring is required by means of the proposed checkbox.
  The part profile is followed at the end of recessing. This is done by machining down the sides of the recess in order to clear the profile.
Lead-in, Lift-off and Attack for Recessing

- **Lead-in Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance. The tool is in rapid mode before this distance.

- **Attack Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance.

- **Angle and Distance before Plunge**
  Allows orienting the tool before the plunge.

- **Plunge Distance and Plunge Angle**
  Define the plunge vector before each new pass with respect to the cutting direction.

- **Lift-off Distance and Lift-off Angle**
  Define the lift-off vector at the end of the last pass with respect to the cutting direction.

Example of one-way recessing. Note that Trailing angle is defined on the tool.

In the figure above the tool motion is as follows:
approach in RAPID
lead-in at the first recess pass and plunge approach for other passes
plunge at plunge feedrate
machine at machining feedrate
contouring at contouring feedrate
lift-off at last recess pass at lift-off feedrate.

**Feeds and Speeds for Recessing**

- Speed unit can be set to:
  - Angular: spindle speed in revolutions per minute
  - Linear: constant cutting speed in units per minute

then you can give a Machining Speed value.
- Machining Feedrate in units per revolution
- Lead-in Feedrate, which is applied during the lead-in and attack distance.
- Lift-off Feedrate
- Contouring Feedrate
- Plunge Feedrate
- Dwell setting indicates whether the tool dwell at the end of each path is to be set in seconds or a number of spindle revolutions.

**Compensation for Recessing**

You can select a **tool compensation number** corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

Note that the change of output point is managed automatically if you set the **Change Output Point** option.

If the output point is consistent with the flank of the recess to be machined, the output point is changed when the other flank of the recess is machined.

At the end of the operation, the output point is the same as it was at the start of the operation. See **Changing the Output Point** for more information.

**Approach and Retract Macros for Recessing**

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the approach or retract.

**Grooving Operation**

The Grooving operation allows you to machine a groove by a series of plunging cuts. You can specify:
- external, internal, frontal or inclined machining according to the type of area to machine
- various approach and retract path types
- various lead-in and lift-off options with specific feedrates
- various plunge locations
- tool output point change.

Grooving tools should be used.

**Geometry for Grooving**

Part and Stock profiles are required.

**Orientation, Location and Limits for Grooving**

The following Orientations are proposed: internal, external, frontal and inclined. The selected Orientation defines the type of geometric relimitation to be done between the stock and part geometry in order to determine the area to machine. For an inclined orientation you must specify the **Angle of Incline**.
Part and Stock Thicknesses for Grooving

- Clearance on stock, which is defined perpendicular to the stock profile
- Thickness on part, which is defined perpendicular to the part profile.
- Axial offset on part
- Radial offset on part.

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to the part profile is the resulting value of the normal thickness and the two offsets.

Machining Strategy Parameters for Grooving

Path Definition for Grooving

- **Max Depth of Cut**
  This option is used to specify the maximum distance between plunges.

- **First Plunge**
  You must specify a first plunge position according to the groove orientation by means of the following choice: Left/Down - Center - Right/Up - Automatic.
  Automatic is only available for frontal machining. In this case, the position of the first plunge is deduced on the tool by reading the tool's minimum and maximum cutting diameters.

- **Next Plunges** (if First Plunge is set to Center).
  You can specify the position of the plunges that follow the first plunge with respect to:
  - the spindle axis by means of the To or From Spindle for frontal machining
  - the head stock by means of the To or From Head Stock for internal or external machining
  - the groove by means of Left or Right of Groove for Inclined machining.

- **Part Contouring**
  You can specify if contouring is required by means of the proposed checkbox.
  The part profile is followed at the end of grooving. This is done by machining down the sides of the groove in order to clear the profile.

- **Grooving by Level** mode
  This option allows you to machine the groove in one or more level.
  Multiple-levels mode is particularly useful when the groove is too deep to machine in one level. In this case Maximum grooving depth defines the maximum depth of each level. If it is greater than the Maximum Depth of Cut defined on the tool, the value on the tool is taken into account.

- **Under Spindle Axis Machining**
  When grooving in frontal mode, this option allows you to request machining under the spindle axis.

- **Chip Break**
  You can specify if chip clearing is to be done during machining by setting the check box. In this case you must specify Plunge, Retract and Clear distances.

- **Gouging Safety Angle**
  Angles of the grooving insert are taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Gouging Safety Angle allows you to further reduce this slope.
  Note that a gouging angle can also be defined on the tool to define the maximum slope on which the tool can machine. In this case, the angle that reduces the slope the most will be taken into account.

- **Machining Tolerance**.

Lead-in, Lift-off and Attack for Grooving

- **Lead-in Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance. The tool is in rapid mode before this distance.

- **Attack Distance**
  Defined with respect to the cutting direction and the stock profile with a stock clearance.
  These options allow penetration into the workpiece at a reduced feedrate in order to prevent tool damage.
  Once the attack distance has been run through, the tool moves at machining feedrate.
  When tool motion between two passes is in contact with the part profile, in order to avoid collisions the corresponding feed is the lift-off feedrate and not rapid feedrate.
Lift-off Distance and Lift-off Angle
Define the lift-off vector at the end of each new pass with respect to the cutting direction.

Feeds and Speeds for Grooving

- Speed unit can be set to:
  - Angular: spindle speed in revolutions per minute
  - Linear: constant cutting speed in units per minute
- then you can give a Machining Speed value.
- Contouring Feedrate
- Chip Breaking Feedrate
- Lead-in Feedrate, which is applied during lead-in and attack distances.
- Lift-off Feedrate
- First Plunge Feedrate and Next Plunges Feedrate
  Different feedrates can be assigned to the first plunge and the following plunges.
- Dwell setting indicates whether the tool dwell at the end of a path or a plunge is to be set in seconds or a number of spindle revolutions.

Compensation for Grooving

You can select a tool compensation number corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

Note that the change of output point is managed automatically if you set the Change Output Point option. If the output point is consistent with the flank of the groove to be machined, the output point is changed when the other flank of the groove is machined. At the end of the operation, the output point is the same as it was at the start of the operation. See Changing the Output Point for more information.

Approach and Retract Macros for Grooving

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the approach or retract.

Profile Finishing Operation

The Profile Finishing operation allows you to finish a part profile. You can specify:

- the type of machining according to the profile of the area to machine (external, internal or frontal)
- re-limitation of the profile by start and end elements
- various approach and retract path types
- linear and circular lead-in and lift-off options with specific feedrates
- recess machining
- various corner processing options
- cutter compensation.

External and Internal tools can be used.

Geometry for Profile Finishing

A Part profile is required.
**Start Limit**: Profile end / To / On / Past
This option allows you to specify a point, line or curve as the start element of the part profile. The position of the start of machining is also defined with respect to this element.
- Profile end: the profile is machined from its first extremity (with respect to machining location).
- TO, ON or PAST: allows you to specify the Go-Go type positioning of the tool with respect to the start element.
  - The ON option is always used for a point type start element.
  - If needed, the profile may be extrapolated to the start element.

**End Limit**: Profile end / To / On / Past
This option allows you to specify a point, line or curve as the end element of the part profile. The position of the end of machining is also defined with respect to this element.
- Profile end: the profile is machined to its last extremity (with respect to machining location).
- TO, ON or PAST: allows you to specify the Go-Go type positioning of the tool with respect to the end element.
  - The ON option is always used for a point type end element.
  - If needed, the profile may be extrapolated to the end element.

---

**Orientation and Location for Profile Finishing**

**Orientation**: Internal / External / Frontal
This option allows you to specify the type of machining according to the location of the area to machine on the part.

**Location**:
- Front, the profile is machined toward the head stock
- Back, the profile is machined from the head stock.

**Corner Processing for Profile Finishing**

The following options allow you to define how corners of the profile are to be machined:
- None: no corners are to be machined along the profile
- Chamfer: only 90 degree corners of the profile are chamfered
- Rounded: all corners of the profile are rounded.
Corner processing options are also available to define how the entry and exit corners are to be machined. Entry and exit corners are defined by either a chamfer length, or a corner radius and corner angle.

**Part Thicknesses for Profile Finishing**

- **Thickness on part**, which is defined perpendicular to the part profile.
- **Axial offset on part**.
- **Radial offset on part**.
- **Start limit clearance**: distance with respect to the start element (only if start element is a line or a curve, and when TO or PAST mode is set for start element positioning).
- **End limit clearance**: distance with respect to the end element (only if end element is a line or a curve, and when TO or PAST mode is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to the part profile is the resulting value of the normal thickness and the two offsets.

**Machining Strategy Parameters for Profile Finishing**

**Path Definition for Profile Finishing**

- **Machining Direction**: To or From Spindle
  This option is only available for frontal machining for specifying the machining direction with respect to the spindle axis.
  If start and end elements are defined that are in conflict with the machining direction, then these elements will be reversed automatically.
- **Contouring for Outside Corners**: Angular / Circular
  Allows you to define whether angular or circular contouring is to be applied to corners of the profile (only if corner processing is set to Rounded or Chamfer).
**Under Spindle Axis Machining**
When finishing in frontal mode, this option allows you to request machining under the spindle axis.

**Recess Machining**
When this option is set, the trailing safety angle option is available.

**Leading and Trailing Safety Angles**
The insert geometry is taken into account to avoid collision by reducing the maximum slope on which the tool can machine. The Leading Safety Angle and Trailing Safety Angle allow you to further reduce this slope. Note that leading and trailing angles can also be defined on the tool to define the maximum slope on which the tool can machine. In this case, the angles that reduce the slope the most will be taken into account.

**Machining Tolerance** for following the profile.

**Lead-in, Lift-off and Attack for Profile Finishing**

- **Lead-in type**: Linear / Circular
  - Defines the type of lead-in onto the profile at lead-in feedrate
    - Linear: lead-in up to the point where profile machining starts is defined by means of the **lead-in distance** and **lead-in angle** options.
    - Circular: lead-in is circular and tangent to the point where profile machining starts. It is defined by means of the **lead-in radius** and **lead-in angle** options.
- **Lift-off type:** Linear / Circular.
  Defines the type of lift-off from the profile at lift-off feedrate
  - Linear: lift-off from the point where profile machining ends is defined by means of the **lift-off distance** and **lift-off angle** options.
  - Circular: lift-off is circular and tangent from the point where profile machining ends. It is defined by means of the **lift-off radius** and **lift-off angle** options.

In the example below, the round tool is tangent TO start element plus clearance at start of profiling. Round tool is tangent PAST end element plus clearance at end of profiling.

### Feeds and Speeds for Profile Finishing
- **Speed unit** can be set to:
  - Angular: spindle speed in revolutions per minute
  - Linear: constant cutting speed in units per minute
  then you can give a **Machining Speed** value.
- **Machining Feedrate** in units per revolution
- **Chamfering Feedrate** for machining chamfers or corners (in units per revolution)
- **Lift-off Feedrate** in units per revolution
- **Lead-in Feedrate** in units per revolution.

### Compensation for Profile Finishing
You can select a **tool compensation number** corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

**Cutter Compensation:** NONE / ON / Reverse.
If this option is set to ON or Reverse, the NC output will include CUTCOM instructions in approach and retract paths for cutter compensation.
- ON: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to the left of the toolpath.
- Reverse: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool is to the right of the toolpath.

See [Cutter Compensation with Finish Operations](#) for more information.

### Approach and Retract Macros for Profile Finishing
The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the
approach or retract.

**Groove Finishing Operation**

The Groove Finishing operation allows you to finish a groove by means of downward profile following. You can specify:

- the type of machining according to the groove profile to be machined (external, internal, frontal or inclined)
- relimitation of the profile by start and end elements
- various approach and retract path types
- linear and circular lead-in and lift-off options with specific feedrates
- various corner processing options with specific feedrates
- local feedrates for individual elements of the machined profile
- tool output point change
- cutter compensation.

Grooving tools or round inserts should be used.

**Geometry**

The Part profile is required.

- **Start Limit**: Profile end / TO / ON / PAST
  This option allows you to specify a point, line or curve as the start element of the groove finish profile. The position of the start of machining is also defined with respect to this element.
  - Profile end: the groove finish profile is machined from its first extremity (with respect to the machining direction).
  - TO, ON or PAST: allows you to specify the Go-Go type positioning of the tool with respect to the start element.
    The ON option is always used for a point type start element.
  If needed, the groove finish profile may be extrapolated to the start element.

- **End Limit**: Profile end / TO / ON / PAST
  This option allows you to specify a point, line or curve as the end element of the groove finish profile. The position of the end of machining is also defined with respect to this element.
  - Profile end: the groove finish profile is machined to its last extremity (with respect to the machining direction).
  - TO, ON or PAST: allows you to specify the Go-Go type positioning of the tool with respect to the end element.
    The ON option is always used for a point type start element.
  If needed, the groove finish profile may be extrapolated to the end element.

**Orientation for Groove Finishing**

- **Orientation**: Internal / External / Frontal / Inclined
  This option allows you to define the orientation of the groove to be machined.
  For an inclined orientation you must specify the Angle of Incline.

**Corner Processing for Groove Finishing**

The following options allow you to define how corners of the profile are to be machined:

- Follow profile: no corners are to be machined along the profile
- Chamfer: only 90 degree corners of the profile are chamfered
- Rounded: all corners of the profile are rounded.

Corner processing is proposed for **Entry, Exit** and **Other corners**.

- Chamfer Length if Other corner processing mode is Chamfer.
- Corner Radius if Other corner processing mode is Rounded.
- Entry Corner Chamfer Length on first flank of groove when Entry corner processing mode is Chamfer
- Entry Corner Radius on first flank of groove when Entry corner processing mode is Corner
Entry Corner Angle on first flank of groove when Entry corner processing mode is Corner
Exit Corner Chamfer Length on last flank of groove when Exit corner processing mode is Chamfer
Exit Corner Radius on last flank of groove when Exit corner processing mode is Corner
Exit Corner Angle on last flank of groove when Exit corner processing mode is Corner.

Part Thicknesses for Groove Finishing
- **Thickness on Part**, which is defined perpendicular to the part profile.
- **Axial Offset on Part**
- **Radial Offset on Part**
- **Start Limit Clearance**: distance with respect to the start element (only if start element is a line or a curve, and when TO or PAST mode is set for start element positioning).
- **End Limit Clearance**: distance with respect to the end element (only if end element is a line or a curve, and when TO or PAST mode is set for end element positioning).

Radial and axial offsets can be positive or negative with any absolute value. The thickness applied to the part profile is the resulting value of the normal thickness and the two offsets.

Machining Strategy Parameters for Groove Finishing

Path Definition for Groove Finishing
- **Machining Direction**
  You can specify the machining direction by means of:
  - To or From Head for Internal and External machining
  - To or From Spindle for Frontal machining
  - To Right or Left of Groove for Inclined machining

  If start and end elements are defined that are in conflict with the machining direction, then these elements will be reversed automatically.
- **Next Flank Clearance**: this value defines the clearance to be applied to the next flank after the first machined flank. The bottom of the groove will be machined up to the position defined by this clearance value.
- **Tool Overlap Distance On Groove Bottom**
- **Under Spindle Axis Machining**
  When finishing in frontal mode, this option allows you to request machining under the spindle axis.
- **Contouring for Outside Corners: Angular / Circular**
  Allows you to define whether an angle or circle contouring mode is to be applied to corners of the groove profile (only if corner processing is set to NONE or CHAMFER).
- **Machining Tolerance** for following the groove finish profile.

Lead-in for Groove Finishing
- **First Flank Lead-in: Linear / Circular**
  Defines the type of lead-in at lead-in feedrate on the first flank of the groove.
  - Linear: lead-in up to the point where first flank machining starts is defined by means of the **first lead-in distance** and **first lead-in angle** options.
  - Circular: lead-in is circular and tangent to the point where first flank machining starts. It is defined by means of the **first lead-in radius** and **first lead-in angle** options.

The example below shows Linear lead-in and Circular lift-off for groove finishing.
**Last Flank Lead-in: Linear / Circular**
Defines the type of lead-in at lead-in feedrate on the last flank of the groove.
- Linear: lead-in up to the point where last flank machining starts is defined by means of the last lead-in distance and last lead-in angle options.
- Circular: lead-in is circular and tangent to the point where last flank machining starts. It is defined by means of the last lead-in radius and last lead-in angle options.

**Other Flank Lead-in: Linear / Circular**
For a groove that has multiple recesses, this option defines the type of lead-in required to machine flanks other than the first and last flanks.
- **Other Lead-in Distance** on other flanks of the groove when other flank lead-in type is Linear
- **Other Lead-in Angle** on other flanks of the groove when other flank lead-in type is Linear or Circular
- **Other Lead-in Radius** on other flanks of the groove when other flank lead-in type is Circular.

**Lift-off for Groove Finishing**
- **Lift-off Type: Linear / Circular**
  Defines the type of lift-off from the groove at lift-off feedrate.
  - Lift-off Distance when lift-off type is Linear.
  - Lift-off Angle when lift-off type is Linear or Circular.
  - Lift-off Radius when lift-off type is Circular.

**Feeds and Speeds for Groove Finishing**
- Speed unit can be set to:
  - Angular: spindle speed in revolutions per minute
  - Linear: constant cutting speed in units per minute
then you can give a Machining Speed value.

- **Machining Feedrate** in units per revolution
- **Chamfering Feedrate** for machining chamfers or corners (in units per revolution)
- **Lift-off Feedrate** in units per revolution
- **Lead-in Feedrate** in units per revolution.

**Compensation for Groove Finishing**

You can select a **tool compensation number** corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

**Cutter Compensation**: None / On / Reverse

If this option is set to On or Reverse, the NC output will include CUTCOM instructions in approach and retract paths for cutter compensation.

- **On**: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to the left of the toolpath.
- **Reverse**: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool is to the right of the toolpath.

See [Cutter Compensation with Finish Operations](#) for more information.

Note that the change of output point is managed automatically if you have set the **Output Point Change** option. If the output point is consistent with the flank of the groove to be machined, the output point is changed when the other flank of the groove is machined. At the end of the operation, the output point is the same as it was at the start of the operation. See [Changing the Output Point](#) for more information.

**Approach and Retract Macros for Groove Finishing**

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the approach or retract.

**Threading**

The Threading operation allows you to specify:

- the type of machining according to the required thread (external or internal)
- relimitation of the profile by start and end elements
- thread machining options
- various approach and retract types
- PP Word syntaxes.

External and Internal threading tools can be used.

**Geometry for Threading**

A Part profile is required.

- **End Limit**: Profile end / To / On / Past
  This option allows you to specify a point, line or curve as the end element of the profile to be machined. The position of the end of machining is also defined with respect to this element.

  - Profile end: the profile is machined to its last extremity (with respect to machining location).
  - To, On or Past: allows you to specify the Go-Go type positioning of the tool with respect to the end element. The On option is always used for a point type end element.

If needed, the profile may be extrapolated to the end element.

- **End Limit Clearance**: distance with respect to the end element (only if end element is a line or a curve, and when To or Past mode is set for end element positioning).
**Start Limit**: Profile end / To / On / Past
This option allows you to specify a point, line or curve as the start element of the profile to be machined. The position of the start of machining is also defined with respect to this element.

- Profile end: the profile is machined to its first extremity (with respect to machining location).
- To, On or Past: allows you to specify the Go-Go type positioning of the tool with respect to the start element. The On option is always used for a point type end element.

If needed, the profile may be extrapolated to the start element.

**Start Limit Clearance**: distance with respect to the start element (only if start element is a line or a curve, and when To or Past mode is set for start element positioning).

**Orientation and Location for Threading**

- **Orientation**: Internal / External
  This option allows you to specify the type of machining according to the location of the area to machine on the part.
- **Location**: Front / Back
  - Front, the profile is machined toward the head stock
  - Back, the profile is machined from the head stock.

**Threads**

- **Thread profile**: ISO / Trapezoidal / UNC / Gas / Other
  Other allows defining a specific thread profile.
- **Thread unit**: Pitch / Threads per Inch
  You must specify the thread type when the Thread profile is Other. Thread is automatically set to Pitch for the ISO and Trapezoidal types and set to Threads per Inch for UNC and Gas.
- **Nominal diameter**: This value must be given when Thread type is internal and Thread profile is Other.
- **Thread length**: This value must be given when the Start or End relimiting element is set to Profile End.
- **Thread pitch**: This value must be given when the Thread type is set to Pitch or the Thread profile is ISO or Trapezoidal.
- **Threads/inch**: This value must be given when the Thread type is set to Thread per inch or when the Thread profile is UNC or Gas.
- **Thread depth**: This value must be given when the Thread profile is Other.
- **Number of threads**: When greater than 1, this value allows you to specify whether a multi-start thread is to be machined.

**Machining Strategy Parameters for Threading**

**Machining Options for Threading**

- **Threading type**. You must choose the desired threading type:
  - Constant depth of cut
  - Constant section of cut
- **Maximum depth of cut** when Threading type is set to Constant depth of cut
- **Number of passes** when Threading type is set to Constant section of cut. When the number of passes is defined, the Section of cut value is automatically set.
- **Machining spindle speed**
- **Thread Penetration type**:
  - Straight
  - Oblique
  - Alternate.
  Penetration angle must be specified for Oblique or Alternate entry types.

**Path Computation options for Threading**
Clearance on crest diameter
Lead-in Distance
Lift-off Distance and Lift-off Angle.

First and Last Passes options for Threading

- Manage penetration on first passes check box. This option is available when Threading type is set to Constant section of cut. You must specify values for:
  - Number of first passes
  - First section rate.

  When these two values are specified, the Section of cut for first passes value is automatically set.

- Manage penetration on last pass check box. When activated, you must specify:
  - Number of last passes
  - Depth of cut for last passes.

- Spring pass check box. When activated, you must specify a Number of spring passes.

Compensation for Threading

You can select a tool compensation number corresponding to the desired tool output point. Note that the usable compensation numbers are defined on the tool assembly linked to the machining operation. If you do not select a tool compensation number, the output point corresponding to type P9 will be used by default.

Note that the change of output point is managed automatically if you set the Change Output Point option for Trapezoidal or Other Thread profile.

Approach and Retract Macros for Threading

The following Approach and Retract macros are proposed: direct, axial-radial, radial-axial, and none. The selected type (approach or retract) defines the tool motion before or after machining: the tool moves in rapid motion during the approach or retract.
The **Cutter Compensation**: *None / On / Reverse* option is proposed for finish operations. If this option is set to On or Reverse, the NC output will include CUTCOM instructions in the APT or clfile output for cutter compensation (CUTCOM/RIGHT, CUTCOM/LEFT, CUTCOM/OFF).

- **ON**: CUTCOM/RIGHT instruction generated if tool is to the right of the toolpath and CUTCOM/LEFT if tool is to the left of the toolpath.
- **Reverse**: CUTCOM/RIGHT instruction generated if tool is to the left of the toolpath and CUTCOM/LEFT if tool is to the right of the toolpath.

Otherwise, if the option is set to NONE, no CUTCOM instruction will be included in the NC data output.

A CUTCOM instruction is always generated before a linear trajectory in order to be active on that displacement:

- for a tool approach, the instruction CUTCOM/RIGHT or CUTCOM/LEFT is generated at latest in the approach phase of the trajectory, before the lead-in and on a linear trajectory.
- for a tool retract, the instruction CUTCOM/OFF is generated at earliest in the retract phase of the trajectory, before a linear trajectory or the last point of the operation.

The figure below illustrates a Profile Finishing operation that has circular lead-in and linear lift-off.

If the cutter compensation is set to ON, the CUTCOM instructions are generated as follows:

- CUTCOM/RIGHT is generated at point 1, before the tool motion to point 2. Note that if lead-in was linear, CUTCOM/RIGHT would be generated at point 2, before the tool motion to point 3.
- CUTCOM/OFF is generated at point 4, before the tool motion to point 5. Note that if lift-off was circular CUTCOM/OFF would be generated at point 5, before the linear retract motion.

**How to Use Cutter Compensation**

The computed toolpath corresponds to the trajectory followed by the output point of the tool used in the Part Operation. You should set Cutter Compensation to On in the following cases:

- the cutter radius of the actual tool used for machining is greater than the radius of the programmed tool and a positive compensation value is entered at the NC machine.
- the cutter radius of the actual tool used for machining is less than the radius of the programmed tool and a negative compensation value is entered at the NC machine.

You should set Cutter Compensation to Reverse in the following cases:

- the cutter radius of the actual tool used for machining is less than the radius of the programmed tool and a positive compensation value is entered at the NC machine.
the cutter radius of the actual tool used for machining is greater than the radius of the programmed tool and a negative compensation value is entered at the NC machine.

**Some Recommendations**

In general you should program with tools whose cutter radius is greater than those that will actually be used on the machine. This will help you anticipate tool/part collisions that may arise when cutter compensation is used. If negative compensation values are allowed on the machine, set Cutter Compensation to On. If negative compensation values are not allowed on the machine set Cutter Compensation to:

- On, if the tool actually used has a greater cutter radius than the programmed tool
- Reverse, if the tool actually used has a smaller cutter radius than the programmed tool.

Cutter compensation for profile finishing
Changing the Output Point

An option for changing the tool output point is available for:
- Recessing, Grooving and Groove Finishing operations using grooving tools or inserts
- certain Threading operations using threading tools or inserts.

When the **Change Output Point** option is set the tool output point will be changed automatically during the operation according to the profile geometry to be machined.

For Grooving and Groove Finishing operations, tool output point changes are made out of the profile.

For Recessing operations, tool output point changes are made before each tool motion involving machining (that is, after each plunge). However, changes are only done:
- if machining is consistent with the selected tool output point
- if another output point is defined on the tool so that the tool output point change can be made.

Otherwise, the tool output point will not be changed.

The following figure illustrates tool output point changes in a Groove Finishing operation that uses a grooving tool. In this example, at the start of operation the tool output point is P9.

If the first flank to machine is flank 1, the tool motion is as follows:
- approach and lead-in motion to flank 1
- machine down flank 1
- lift-off from part profile
- tool output point change: tool output point is P9R
- approach and lead-in motion to flank 2
machine down flank 2
lift-off to Exit Point
tool output point change: tool output point is P9 (as at start of operation).

If the first flank to machine was flank 2, the tool motion would be as follows:
- tool output point change: tool output point is P9R
- approach and lead-in motion to flank 2
- machine down flank 2
- lift-off from part profile
- tool output point change: tool output point is P9 and the guiding point is LEFT
- approach and lead-in motion to flank 1
- machine down flank 1
- lift-off to Exit Point.

- If P9 is the tool output point and if the output point P9R is defined on the tool, the output point change is only done for grooving tools.
- The tool output point at the end of operation is the same as at the start of operation.

The figure below illustrates a Recessing operation when a round insert is used. The tool output point changes during an operation only if the output point at the start of operation is P2, P3 or P9 for a frontal recess or P3, P4 or P9 for an external recess.

The tool output point is dependent on the machine axis system.
### Glossary

<table>
<thead>
<tr>
<th>A</th>
<th>Motion defined for approaching the operation start point</th>
</tr>
</thead>
<tbody>
<tr>
<td>auxiliary command</td>
<td>A control function such as tool change or machine table rotation. These commands may be interpreted by a specific post-processor.</td>
</tr>
<tr>
<td>axial machining operation</td>
<td>Operation in which machining is done along a single axis and is mainly intended for hole making (drilling, counter boring, and so on).</td>
</tr>
<tr>
<td>D</td>
<td>Digital Process for Manufacturing.</td>
</tr>
<tr>
<td>E</td>
<td>Defines the end type of a hole as being through hole or blind.</td>
</tr>
<tr>
<td>F</td>
<td>Rate at which a cutter advances into a work piece. Measured in linear or angular units (mm/min or mm/rev, for example).</td>
</tr>
<tr>
<td>fixture</td>
<td>Elements used to secure or support the workpiece on a machine.</td>
</tr>
<tr>
<td>G</td>
<td>Area where the tool has removed too much material from the workpiece.</td>
</tr>
<tr>
<td>M</td>
<td>An auxiliary command in the program that corresponds to a rotation of the machine table.</td>
</tr>
<tr>
<td>machining axis system</td>
<td>Reference axis system in which coordinates of points of the tool path are given.</td>
</tr>
<tr>
<td>machining operation</td>
<td>Contains all the necessary information for machining a part of the workpiece using a single tool.</td>
</tr>
<tr>
<td>machining tolerance</td>
<td>The maximum allowed difference between the theoretical and computed tool path.</td>
</tr>
</tbody>
</table>
manufacturing process Defines the sequence of part operations necessary for the complete manufacture of a part.

manufacturing program Describes the processing order of the NC entities that are taken into account for tool path computation: machining operations, auxiliary commands and PP instructions.

offset Specifies a virtual displacement of a reference geometric element in an operation (such as the offset on the bottom plane of a pocket, for example). Compare with thickness.

one way Machining in which motion is always done in the same direction. Compare with zig zag.

part operation Links all the operations necessary for machining a part based on a unique part registration on a machine. The part operation links these operations with the associated fixture and set-up entities.

PP instruction Instructions that control certain functions that are auxiliary to the tool-part relationship. They may be interpreted by a specific post processor.

PPR Process Product Resources.

retract macro Motion defined for retracting from the operation end point

safety plane A plane normal to the tool axis in which the tool tip can move or remain a clearance distance away from the workpiece, fixture or machine.

set up Describes how the part, stock and fixture are positioned on the machine.

spindle speed The angular speed of the machine spindle. Measured in linear or angular units (m/min or rev/min, for example).

stock Workpiece prior to machining by the operations of a part operation.

thickness Specifies a thickness of material to be removed by machining. Compare with offset.
<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tool axis</td>
<td>Center line of the cutter.</td>
</tr>
<tr>
<td>tool change</td>
<td>An auxiliary command in the program that corresponds to a change of tool.</td>
</tr>
<tr>
<td>tool clash</td>
<td>Area where the tool collided with the workpiece during a rapid move.</td>
</tr>
<tr>
<td>tool path</td>
<td>The trajectory that the tool follows during a machining operation.</td>
</tr>
<tr>
<td>total depth</td>
<td>The total depth including breakthrough distance that is machined in a hole making operation.</td>
</tr>
<tr>
<td>undercut</td>
<td>Area where the tool has left material behind on the workpiece.</td>
</tr>
<tr>
<td>zig zag</td>
<td>Machining in which motion is done alternately in one direction then the other. Compare with one way.</td>
</tr>
</tbody>
</table>
Index

A

Auxiliary operations

E

Edit Parameters dialog box

F

Face
  Roughing operation
  Face Roughing operation

G

Groove Finishing operation
  Grooving operation

L

Longitudinal
  Roughing operation
  Longitudinal Roughing operation
Parallel Contour
  Roughing operation
Parallel Contour Roughing operation
Profile Finishing operation

Recessing operation
Roughing operation
  Face
  Longitudinal
  Parallel Contour

Threading operation